Lecture 3: MATLAB/Simulink – Crash Course
Lecture 3

MATLAB/Simulink Crash–Course

- MATLAB/Simulink
- DC Motor Model
We **simulate** a model to study the behavior of a system.

We need to **verify** that our model is correct – expect results.

Knowing how to use Simulink or MATLAB does not mean that you know how to model a system.
Simulink

- Used to model, analyze and simulate dynamic systems using block diagrams.
- Simulink is a graphical, **drag and drop** environment for building simple and complex signal and system dynamic simulations – therefore is easy to use.
- It allows users to concentrate on the structure of the problem, rather than having to worry about a programming language.
- We simulate a model to study the behavior of a system – need to verify that our model is correct.
- However **modeling a system is not necessarily easy!**
Launch Simulink

- to start simulink: at Matlab command line, type:
  ```matlab
  >> simulink
  ```

- or click on the “Home Toolstrip”
Launch Simulink

- The Simulink library should appear
Simulink Libraries

- **Sources**: blocks that have only output, generators, constant,
- **Sinks**: blocks that have only input, scope, to workspace.
- **Continuous**: integrator, transfer function.
- **Discrete**: discrete transfer function, unite delay, memory.
- **Math operations**: gain, product, sum, trig. functions.
- **User defined functions**: S-function, S-function builder.
- **SimPowersystem**: Electrical blocks – electrical sources, machines, measurements.
Simulink Libraries

Mohammed Ahmed (Assoc. Prof. Dr.Ing.)

13.03.2016 8 / 39
Create a new model

- Click File-New (upper left corner) to create a new workspace
Building the model

- Model is created by choosing the blocks from different libraries, **dragging** them to model window and linking them.
- The **parameters** of block, can be reached with double click on the block.
Select an input block

- Drag a Sine Wave block from the Sources library to the model window
Select an operator block

Continuous-time integration of the input signal.
Select an output block

- Drag a Scope block from the Sinks library to the model window
Connect blocks with signals

- Place your cursor on the output port (>) of the Sine Wave block
- Drag from the Sine Wave output to the Integrator input
- Drag from the Integrator output to the Scope input
- Arrows indicate the direction of the signal flow
Set block parameters

- The parameters of block (shown on picture, sine wave and integrator parameters), can be reached with double click on the block.
Configuration parameters

- Numerical solver method, start time, stop time (it can be also set directly)
Run the simulation

- In the model window, from the Simulation pull-down menu, select Start
Simulation results

- Double-click on the Scope to view the simulation results
Now, let’s build a simple model!

This model plots the sign of the input signal.
Example -- Step 1

Step 1: Start Simulink and choose New then Model from the File menu.
Example -- Step 2

Step 2: Copy the needed blocks by using Drag and Drop.
Example -- Step 3

Step 3: Complete the connection.

- Move the mouse to the location of output port of the source block.
- Hold down the mouse button and move the cursor to the input port of the destination block.
- Release the mouse button.
Example -- Step 4

Step 4: Set the block parameters.

Double click a block to open its block parameters.
Example -- Step 5

Step 5: Setup the simulation parameters.

- **Start time**: 0.0
- **Stop time**: 10.0
- **Solver type**: Variable-step
- **Max step size**: auto
- **Min step size**: auto
- **Initial step size**: auto
- **Refine output**: Refine factor: 1
Example -- Step 6

Step 6: Start simulation.
Manipulating blocks

Select a corner and drag to resize a block

Rotating a block

Single click on the block label to change block name
Labels and Annotations

This is a simple example!
Moving a line segment

Step 1: Position the pointer on the segment you want to move.

Step 2: Press and hold down the left mouse button.

Step 3: Drag the pointer to the desired position.
Dividing a line into segments

Step 1: Select the line.

Step 2: Position the pointer on the line where you want the vertex.

Step 3: While holding down the Shift key, press and hold down the mouse button.

Step 4: Drag the pointer to the desired location.
Inserting a block in a line

**Step 1:** Position the pointer over the block and press the left mouse button.

**Step 2:** Drag the block over the line in which you want to insert the block.

**Step 3:** Release the mouse button to drop the block on the line.
Subsystems can hide the complexity of the subsystems from the user, which can make your model clearer. There are two ways to create Subsystems:

- You can create a Subsystem by adding the Subsystem block from Signals & Systems. Then you can edit the Subsystem by double-clicking the Subsystem block.
- You can create a subsystem by grouping blocks from an existing system.
1. Use the mouse to select the blocks

2. Choose Create Subsystem from the Edit menu

3. This replaces the selected blocks with a Subsystem block.
DC Motor, How it works?

https://www.youtube.com/watch?v=LAtPHANEfQo
DC Motor
Building Blocks

- Stator Winding
- Rotor Windings
- Commutator
- Bearings
- Shaft
- Brush
- Inertia
- Load
- Angle $\theta$
- Torque $T$

Mohammed Ahmed (Assoc. Prof. Dr. Ing.)
Actuators and Drives
19.02.2016 17 / 20
DC Motor
Model

Equivalent Electric Circuit

We assume:

- input of the system is the voltage source \( V \) applied to the motor armature
- output is the rotational speed of the shaft \( \omega = \frac{d\theta}{dt} \)
- rotor and shaft are assumed to be rigid.
- viscous friction torque proportional to shaft angular velocity.
applying Kirchoff law to the motor system

\[ V = R i + L \frac{di}{dt} + e_b \]  

back EMF, \( e_b \) is proportional to angular velocity of shaft by a constant factor \( K_e \),

\[ e_b = K_e \omega \]  

torque generated by the motor is proportional to armature current and the strength of the magnetic field. Since magnetic field is constant, therefore,

\[ T = K_t i \]  

where \( K_t \) is torque constant.

\[ T = J \frac{d^2\theta}{dt^2} + b \frac{d\theta}{dt} \]  

where \( J \) and \( b \) are moment of inertia of the rotor and viscous coefficient, resp.
The motor torque, $T$, is related to the armature current, $i$, by:

$$T = K_t i$$

The back emf, $E_b$, is related to the angular velocity by:

$$e_b = K_e \omega$$

The dynamic equations for electrical and mechanical balance from Kirchhoff’s law and Newton’s law are

$$\frac{di}{dt} = \frac{V}{L} - \frac{R}{L} i - \frac{k_e}{L} \omega$$

$$\frac{d\omega}{dt} = \frac{k_t}{J} i - \frac{b}{J} \omega$$
1 Show that the two units, Nm/A and V/rad/s, are identical.

2 Develop a MATLAB/Simulink model of the brushed DC motor with the following parameters:

- $J$ moment of inertia of the rotor: 0.01 kg.m$^2$
- $b$ motor viscous friction constant: 0.1 N.m.s
- $K_e$ electromotive force constant: 0.01 V/rad/s
- $K_t$ motor torque constant: 0.01 N.m/A
- $R$ electric resistance: 1 Ω
- $L$ electric inductance: 0.5 H
DC Motor Modeling

\[ \int \int \frac{d^2 \theta}{dt^2} \, dt = \int \frac{d\theta}{dt} \, dt = \theta \]

\[ \int \frac{di}{dt} \, dt = i \]

\[
\begin{align*}
\frac{d^2 \theta}{dt^2} &\rightarrow \text{Integrator} \rightarrow \frac{1}{s} \\
\frac{di}{dt} &\rightarrow \text{Integrator} \rightarrow \frac{1}{s}
\end{align*}
\]

Mohammed Ahmed (Assoc. Prof. Dr.Ing.)
DC Motor Modeling

\[ J \frac{d^2 \theta}{dt^2} = T - b \frac{d \theta}{dt} \implies \frac{d^2 \theta}{dt^2} = \frac{1}{J} (K_f i - b \frac{d \theta}{dt}) \]

\[ L \frac{di}{dt} = -Ri + V - e \implies \frac{di}{dt} = \frac{1}{L} (-Ri + V - K_b \frac{d \theta}{dt}) \]

\[ \text{Add1} \rightarrow \text{Inertia} \rightarrow \text{Integrator1} \]

\[ \text{Add} \rightarrow \text{Inductance} \rightarrow \text{Integrator} \]
DC Motor Modeling

![Motor Model Diagram]

- Add1
- Inductance
- Integrator
- K
- Add
- Inertia
- Integrator
- Damping
- b

Equations:
\[ v = K \times i - b \times \dot{\theta} \]
\[ \dot{\theta} = \frac{1}{J} \times (v - b \times \dot{\theta}) \]
\[ \dot{i} = \frac{1}{L} \times (E - R \times i - K \times i) \]
DC Motor Modeling

![Motor Model/DC Motor Diagram](image)

- Voltage
- Resistance
- Inductance
- Integrator
- Damping
- Add
- Add1
- 1/L
- 1/J
- 1/s
- Speed
- b
- K
- Ke
- Kt

Actuators and Drives
DC Motor Modeling

Simulation Results
for a DC motor, mechanical and electrical equations are:

\[ T = K_t i \]  \hspace{1cm} (5)

\[ V = R i + L \frac{di}{dt} + K_t \omega \]  \hspace{1cm} (6)

For a fixed voltage, torque–speed curves are derived from (5) & (6):

\[ T = \frac{k_t}{R} (V - K_t \omega) = \frac{k_t}{R} V - k_m^2 \omega \]  \hspace{1cm} (7)

- \( K_m = \frac{k_t}{\sqrt{R}} \) is the motor constant, \( [\text{Assig. 1: numerically, } k_t = k_e] \)
- slope of the torque–speed curves is \( -k_m^2 \)
- voltage-controlled DC motor has inherent damping in its mechanical behavior
- torque increases in proportion to the applied voltage
- torque reduces as the angular velocity increases
for a DC motor, mechanical and electrical equations are:

\[ T = K_t i \quad (5) \]
\[ V = R i + L \frac{di}{dt} + K_t \omega \quad (6) \]

For a fixed voltage, torque–speed curves are derived from (5) & (6):

\[ T = \frac{k_t}{R} (V - K_t \omega) = \frac{k_t}{R} V - k_m^2 \omega \quad (7) \]

- \( k_m = \frac{k_t}{\sqrt{R}} \) is the motor constant, [Assig. 1: numerically, \( k_t = k_e \)]
- slope of the torque–speed curves is \(-k_m^2\).
- voltage-controlled DC motor has inherent damping in its mechanical behavior
- torque increases in proportion to the applied voltage,
- torque reduces as the angular velocity increases
for a DC motor, mechanical and electrical equations are:

\[ T = K_t \, i \]  \hspace{1cm} (5)

\[ V = R \, i + L \, \frac{di}{dt} + K_t \, \omega \] \hspace{1cm} (6)

For a fixed voltage, torque–speed curves are derived from (5) & (6):

\[ T = \frac{k_t}{R} (V - K_t \, \omega) = \frac{k_t}{R} V - k_m^2 \, \omega \] \hspace{1cm} (7)

- \( k_m = \frac{k_t}{\sqrt{R}} \) is the **motor constant**, [Assig. 1: numerically, \( k_t = k_e \)]
- slope of the torque–speed curves is \(-k_m^2\).
- voltage-controlled DC motor has inherent damping in its mechanical behavior
- torque increases in proportion to the applied voltage
- torque reduces as the angular velocity increases
for a DC motor, mechanical and electrical equations are:

\[ T = K_t i \]  \hspace{1cm} (5)

\[ V = R i + L \frac{di}{dt} + K_t \omega \]  \hspace{1cm} (6)

For a fixed voltage, torque–speed curves are derived from (5) & (6):

\[ T = \frac{k_t}{R} (V - K_t \omega) = \frac{k_t}{R} V - k_m^2 \omega \]  \hspace{1cm} (7)

- \( K_m = \frac{k_t}{\sqrt{R}} \) is the motor constant. [Assig. 1: numerically, \( k_t = k_e \)]
- slope of the torque–speed curves is \(-K_m^2\).
- voltage-controlled DC motor has inherent damping in its mechanical behavior.
- torque increases in proportion to the applied voltage.
- torque reduces as the angular velocity increases.
for a DC motor, mechanical and electrical equations are:

\[ T = K_t i \] \hspace{1cm} (5)

\[ V = R i + L \frac{di}{dt} + K_t \omega \] \hspace{1cm} (6)

where:
- \( T \) = motor torque
- \( K_t \) = torque constant
- \( i \) = current,
- \( V \) = supplied voltage,
- \( \omega \) = rotor speed,
- \( e_b \) = back-emf (\( e_b = K_e \omega \)),
- \( R, L \) = resistance and induction.

For a fixed voltage, torque–speed curves are derived from (5) & (6):

\[ T = \frac{k_t}{R} (V - K_t \omega) = \frac{k_t}{R} V - k_m^2 \omega \] \hspace{1cm} (7)

- \( K_m = \frac{k_t}{\sqrt{R}} \) is the motor constant, [Assig. 1: numerically, \( k_t == k_e \)]
- slope of the torque–speed curves is \(-K_m^2\).
- voltage-controlled DC motor has inherent damping in its mechanical behavior
- torque increases in proportion to the applied voltage,
- torque reduces as the angular velocity increases

Mohammed Ahmed (Assoc. Prof. Dr.Ing.)
Actuators and Drives
DC Motor
Torque–Speed Relation

- for a DC motor, mechanical and electrical equations are:

\[ T = K_t i \quad (5) \]
\[ V = R i + L \frac{di}{dt} + K_t \omega \quad (6) \]

- For a fixed voltage, torque–speed curves are derived from (5) & (6):

\[ T = \frac{k_t}{R} (V - K_t \omega) = \frac{k_t}{R} V - k_m^2 \omega \quad (7) \]

- \( K_m = \frac{k_t}{\sqrt{R}} \) is the **motor constant**, [Assig. 1: numerically, \( k_t = k_e \)]
- slope of the torque–speed curves is \(-K_m^2\).
- voltage-controlled DC motor has inherent damping in its mechanical behavior
- torque increases in proportion to the applied voltage,
- torque reduces as the angular velocity increases
DC Motor
Torque–Speed Relation

- for a DC motor, mechanical and electrical equations are:

\[ T = K_t i \]  \hspace{2cm} (5)

\[ V = R i + L \frac{di}{dt} + K_t \omega \]  \hspace{2cm} (6)

- For a fixed voltage, torque–speed curves are derived from (5) & (6):

\[ T = \frac{k_t}{R} (V - K_t \omega) = \frac{k_t}{R} V - k_m^2 \omega \]  \hspace{2cm} (7)

- \( k_m = \frac{k_t}{\sqrt{R}} \) is the **motor constant**, [Assig. 1: numerically, \( k_t = k_e \)]
- slope of the torque–speed curves is \(-k_m^2\).
- voltage-controlled DC motor has inherent damping in its mechanical behavior
- torque increases in proportion to the applied voltage,
- torque reduces as the angular velocity increases
for a DC motor, mechanical and electrical equations are:

\[ T = K_t i \quad (5) \]
\[ V = R i + L \frac{di}{dt} + K_t \omega \quad (6) \]

For a fixed voltage, torque–speed curves are derived from (5) & (6):

\[ T = \frac{k_t}{R} (V - K_t \omega) = \frac{k_t}{R} V - k_m^2 \omega \quad (7) \]

- \( k_m = \frac{k_t}{\sqrt{R}} \) is the motor constant, [Assig. 1: numerically, \( k_t = k_e \)]
- slope of the torque–speed curves is \( -K_m^2 \).
- voltage-controlled DC motor has inherent damping in its mechanical behavior
- torque increases in proportion to the applied voltage,
- torque reduces as the angular velocity increases
DC Motor
Torque–Speed Relation

D.C. Motor Torque/Speed Curve

- Stall torque, $\tau_s$
- Max Power, $P_{\text{max}}$
- No load speed, $\omega_n$
- $\tau_{mp} = 0.5\tau_s$
- $\omega_{mp} = 0.5\omega_n$
Thanks for your attention.

Questions?

Asst. Prof. Dr.Ing.
Mohammed Ahmed
mnahmed@eng.zu.edu.eg
goo.gl/GHZZio

Robotics Research Interest Group (zuR²IG)
Zagazig University | Faculty of Engineering | Computer and Systems Engineering Department | Zagazig, Egypt

Copyright ©2016 Dr.Ing. Mohammed Nour Abdelgwad Ahmed as part of the course work and learning material. All Rights Reserved. Where otherwise noted, this work is licensed under a Creative Commons Attribution-NonCommercial-ShareAlike 4.0 International License.